Veritas System Recovery Disk Help

About recovering a computer

If Windows fails to start or does not run normally, you can still recover your computer. You can use the
Veritas System Recovery Disk and an available recovery point or a virtual disk that you created from a
recovery point.

Note: If you can start Windows and the drive that you want to restore is a non-operating system drive,
you can restore the drive within Windows.

The Veritas System Recovery Disk lets you run a recovery environment that provides temporary access
to Veritas System Recovery 22 recovery features. For example, you can access the recovery features of
Veritas System Recovery 22 to restart the computer into its previous, usable state.

About recovering a Unified Extensible Firmware Interface (UEFI)-based

computer

Veritas System Recovery Disk lets you recover the computers that use the Unified Extensible Firmware
Interface (UEFI) standard. However, consider the following points when you recover UEFI-based
computers:

e You must start UEFI-based computers using the 64-bit version of Veritas System Recovery Disk.

e When you boot a UEFI-based computer, ensure that the system drive and the boot drive are
located on a GPT disk. Similarly, when you boot a BIOS-based computer, your system drive and
boot drive must be located on an MBR disk.

e You cannot restore backups of the boot partition and the system partition of UEFI-based
computers to BIOS-based computers. Backups of UEFI-based computers must be restored to
GPT disks. Similarly, you cannot restore backups of the boot partition and the system partition
of BIOS-based computers to UEFI-based computers. Backups of BIOS-based computers must be
restored to MBR disks.

Note: While you recover your computer using Veritas System Recovery Disk, the firmware type of the
backup is displayed. Depending on the firmware type of the backup, restore the backups to the
appropriate disks, either GPT or MBR.

e |If your computer supports both UEFI and BIOS firmware, and you backed it up in UEFI mode, you
must start the computer using UEFI firmware.

e When you recover UEFI-based computers, do not select the following options on the Edit target
drive and Options panel in the Recover My Computer wizard:



e Set drive active (for booting OS)

¢ Restore master boot record: These options are applicable only for MBR-style disks. They
are not applicable to GPT-style disks.

When you recover UEFI-based computers, you must restore the EFI System Partition first if it
does not exist.

When you recover UEFI-based computers, an empty MSR partition is created if it does not exist.

You cannot recover the boot volumes and the system volumes of UEFI-based computers to
dynamic disks.

Booting a computer by using the Veritas System Recovery Disk

The Veritas System Recovery Disk lets you boot a computer that can no longer run the Windows
operating system. You can create a recovery disk using Veritas System Recovery 22. When you boot your
computer using the Veritas System Recovery Disk, a simplified version of Windows starts that runs a
recovery environment. In the recovery environment, you can access the recovery features of Veritas

System Recovery 22.

Note: Veritas System Recovery Disk requires a minimum of 1.5 GB of RAM to run. If your computer's
video card is configured to share your computer's RAM, you might need more than 1.5 GB of RAM.

To boot a computer by using the Veritas System Recovery Disk

1.

If you store your recovery points on a USB device, attach the device now (for example, an
external hard drive).

Note: You should attach the device before you restart the computer. Otherwise, Veritas System
Recovery Disk might not detect it.

Attach the Veritas System Recovery Disk that is on a USB device, into the media drive. If your
Veritas System Recovery Disk is on a DVD, insert it into the media drive of the computer.

The recovery environment already could be installed on your computer's hard drive. Either
watch your computer monitor after the computer restarts for on-screen instructions.

Restart the computer. If you cannot start the computer from the USB device or DVD, you might
need to change the startup settings on your computer.

As soon as you see the prompt Press any key to boot from DVD or USB device, press a key to
start the Veritas System Recovery Disk.

Note: You must watch for this prompt. It can come and go quickly. If you miss the prompt, you
must restart your computer again.



5.

Read the license agreement, and then click Accept. If you decline, you cannot start Veritas
System Recovery Disk, and your computer restarts.

Configuring a computer to start from a USB device or DVD
Your Veritas System Recovery Disk might be on a USB device or DVD. Accordingly, to run Veritas System

Recovery Disk, you must be able to start your computer using a USB device or DVD.

To configure a computer to start from a USB device or DVD

1.

Turn on your computer.

As the computer starts, watch the bottom of the screen for a prompt that tells you how to
access the BIOS/UEFI setup. Generally, you need to press the Delete key or a function key to
start your computer's BIOS/UEFI program.

In the BIOS/UEFI setup window, select Boot Sequence, and then press Enter.

Follow the on-screen instructions to set the USB device or DVD to be the first startup device in
the list.

Attach the Veritas System Recovery Disk that is on a USB device, into the media drive. If your
Veritas System Recovery Disk is on a DVD, insert it into the media drive of the computer.

Save the changes and exit the BIOS/UEFI setup to restart the computer with the new settings.

Press any key to start Veritas System Recovery Disk. When you start your computer with the
Veritas System Recovery Disk USB device or DVD in the drive, you see a prompt to Press any key
to boot from DVD or USB device. If you do not press a key within five seconds, your computer
attempts to start from the next startup device.

Note: Watch carefully as the computer starts. If you miss the prompt, you must restart the
computer again.

Preparing to recover a computer by checking the hard disk for errors
If you suspect that your hard disk is damaged, you can examine it for errors.

To prepare to recover a computer by checking the hard disk for errors

1.

2.

3.

4.

Boot the computer by using the Veritas System Recovery Disk.
In the Analyze panel of Veritas System Recovery Disk, click Check Hard Disks for Errors.
Select the drive that you want to check.

Select any of the following options.



5.

e Automatically fix file system errors: Fixes the errors on the selected disk. If you do not
select this option, errors are displayed but are not fixed.

* Find and correct bad sectors: Locates the bad sectors and recovers readable information.

Click Start.

Recovering a computer using the Veritas System Recovery Disk
If you have a recovery point for the hard drives that you want to recover, you can fully recover your
computer. Or you can recover a hard drive back to the state it was in when the recovery point was

created.

Note: If you restore a recovery point to a computer that uses different hardware, the Restore Anyware
feature is automatically enabled for you. During such a recovery, you might be prompted to supply disk
drivers, service packs, hot fixes, and so forth. You should have your Windows media CD available.

Warning: Before you restore a computer using Restore Anyware, test your access to the recovery points
in the recovery environment. You should ensure that you have access to SAN volumes and that you can

connect to the network.

You can also recover files and folders from within a recovery point.

To recover a computer using the Veritas System Recovery Disk

1.

Boot the computer by using the Veritas System Recovery Disk.
On the Home panel, click Recover My Computer.
In the Welcome to the Recover My Computer Wizard panel, click Next.

In the Select a Recovery Point to Restore panel, select how you want to view available recovery
points in this panel, and then set the options you want.

If disks with no layout structures are detected, you are prompted to initialize the disk layout. A
list of disks without layout structures is displayed. The list shows the default disk layout type,
either GPT, or MBR. If required, you can change the layout type for the disks, and then click OK
to initialize layouts on them.

Click Next.
In the Drives to Recover panel, set the options you want.
Click Next.

Review the recovery options that you selected. You can optionally select Reboot when finished.
This option automatically restarts the computer after the recovery process finishes.



9. Click Finish, and then click Yes to begin the recovery process.

Select a Recovery Point to Restore options
You use the Select a Recovery Point to Restore panel to help you choose the recovery point that you

want to use to restore your computer.

You can view available recovery points by the following:

¢ The date they were created

e A specific recovery point file name

e The system index that a recovery point creates

The available options in this panel depend on how you view the recovery points.

Table: Select a Recovery Point to Restore options

Option

Description

View recovery points by

Lets you select how you want to view recovery points.
You can view recovery points by the following:

e Date
e Filename
e System

Note: By default, System is selected.
The options available on this wizard panel change based on the selection
you make in this field.

Select source folder
(appears only if you select
Date in View recovery
points by list)

Lets you set the following options based on viewing recovery points by
date:

All local drives: (default) Lists all available recovery point files that may
exist on your computer's local drives.

Browse: Lets you browse to locate a recovery point file (.v2i or .iv2i) on a
local drive. Or, you can browse to a network folder (you may need to
map a network drive first).

Browse for OpenStorage Destination: Lets you browse to select a cloud
storage destination that you want to use for backups.

Map a network drive: Lets you specify a shared network folder path and
assign a drive letter to it. You can then use Browse to locate the
recovery point file you want.

Select a recovery point
(appears only if you select
Date in View recovery
points by list)

Lets you display the recovery points in the order in which they were
created. If no recovery points were discovered, the Select a recovery
point table is empty. In such cases, you can search All local drives on the
computer or Browse to find a recovery point file.

Recovery point folder and
filename

(appears only if you select

Filename in View recovery
points by list)

If you view recovery points by filename, you can type a local drive path
and file name to a recovery point file. Or, you can type a shared network
path and file name to a recovery point file.
e Browse: Lets you browse to locate a recovery point file (.v2i or
.iv2i) on a local drive. Or, you can browse to a network folder




(you may need to map a network drive first).
If the recovery point is located in a hidden drive, you must
specify the location of the hidden drive in the following format:
DiskNo-PartitionNo\Filename.v2i or DiskNo-
PartitionNo\Filename.iv2i
For example, if the hidden drive location is on Disk 2 and
Partition 3, you must enter 2-3\file.v2i. Where 2 is the disk
number and 3 is the partition number.

¢ OpenStorage Destination: Lets you select an OpenStorage
storage destination that you want to use for restoring the
recovery points.

¢ Map a network drive: Lets you specify a shared network folder
path and assign a drive letter to it. You can then use Browse to
locate the recovery point file you want.

System index folder and Lets you type a local drive or shared network path and a file name to the
filename system index file (.sv2i). You can use a system index file to restore a
(appears only if you select computer that has multiple drives.

System in View recovery A system index file reduces the amount of time that is needed to restore
points by list) multiple drives. When a recovery point is created, a system index file is

saved with it. The system index file contains a list of the most recent
recovery points, which includes the original drive location of each
recovery point.
You can set the following options to help you locate a system index file:
e Browse: Lets you browse to locate a system index (.sv2i on a
local drive). Or, you can browse to a network folder (you may
need to map a network drive first).
If the recovery point is located in a hidden drive, you must
specify the location of the hidden drive in the following format:
DiskNo-PartitionNo\Filename.sv2i
For example, if the hidden drive location is on Disk 2 and
Partition 3, you must enter 2-3\file.sv2i. Where 2 is the disk
number and 3 is the partition number.
¢ OpenStorage Destination: Lets you select an OpenStorage
storage destination that you want to use for restoring the
recovery points.
¢ Map a network drive: Lets you specify a shared network folder
path and assign a drive letter to it. You can then use Browse to
locate the system index file you want.

Recovery point details Lets you view various details about the selected recovery point. These
details can help ensure that you have selected the right recovery point
to restore your computer.

Drives to Recover options
You can select each drive that you want to recover.




If necessary, you can add or remove recovery points from the list. If you recover your computer, you can
select the drive on which Windows is installed. On most computer systems, this drive is the C drive. In
the recovery environment, the drive letters and labels might not match what appears in Windows. You
might need to identify the correct drive based on its label, or the name that is assigned to it. Or, you
may need to browse the files and folders in the recovery point.

Table: Drives to Recover options

Option

Description

Select drives to recover

Lets you select the drive on which Windows is installed. On most computer
systems, this drive is the C drive.
In Veritas System Recovery Disk, the drive letters and labels might not
match what appears in Windows. You might need to identify the correct
drive based on its label, or the source name that is assigned to it. Or, you
may need to browse the files and folders within the recovery point.
e Lets you click Add to add another drive from within a recovery
point that you want to recovery. For example, a data drive. See
"Add Drive to Recover options"
e Lets you click Remove to dismiss a selected drive from the
recovery.
e Letsyou click Edit to set the various options that are associated
with restoring the selected drive.

Add

Optional. Lets you add another drive within a recovery point that you want
to recover.

If the recovery point is located in a hidden drive, you must specify the
location of the hidden drive in the following format:
DiskNo-PartitionNo\Filename.v2i or DiskNo-PartitionNo\Filename.iv2i
For example, if the hidden drive location is on Disk 2 and Partition 3, you
must enter 2-3\file.v2i. Where 2 is the disk number and 3 is the partition
number.

Remove

Optional. Lets you select a drive in the Select drives to recover list box and
remove it from the list of drives that you want to recover.

Edit

Optional. Lets you change the various options that are associated with the
target drive of the recovery.

Ignore recovery point
corruption during
restore (potential data
loss)

Automatically excludes the corrupted data and continues to restore the
recovery point. The restored data does not contain the corrupted portion
of data.

Note: There may be potential data loss as corrupted data is excluded from
restore.

Verify recovery point
before restore

Verifies whether a recovery point is valid or corrupt before it is restored. If
the recovery point is invalid, the recovery is discontinued. This option can
significantly increase the time that is required for the recovery to complete.

Do not verify recovery
point before restore

Does not verify whether a recovery point is valid or corrupt before it is
restored. During restore, if there is corrupted data on the recovery point,
an error message is displayed and you cannot restore the recovery point.

Use Restore Anyware to
recover to different

Lets you use the Restore Anyware to restore a recovery point to the
computer hardware that is different from the original on which the




hardware

recovery point was made.
This option is automatically selected for you if any of the following are true:
e You recover a system drive only (the drive on which Windows is
installed; usually the C drive). Or, you recover both a system drive
and one or more data drives to new or to different computer
hardware.
e You upgrade to new or to different computer hardware from an
older computer.
e The motherboard on the computer has failed.
If you recover a data drive only to new or to different computer hardware,
this option is not selected for you.

Add Drive to Recover options
You can use Add Drive to Recover to add another drive from within a recovery point that you want to

restore. For example, a data drive.

Table: Add Drive to Recover options

Option

Description

Recovery point folder and
filename

Lets you type a local drive path and file name or a shared network path
and file name to a recovery point file.

If the recovery point is located in a hidden drive, you must specify the
location of the hidden drive in the following format:
DiskNo-PartitionNo\Filename.v2i or DiskNo-PartitionNo\Filename.iv2i
For example, if the hidden drive location is on Disk 2 and Partition 3, you
must enter 2-3\file.v2i. Where 2 is the disk number and 3 is the partition
number.

Browse

Lets you browse to locate a recovery point file (.v2i or .iv2i) on a local
drive. Or, you can browse to a network folder (you may need to map a
network drive first).

OpenStorage Destination

Lets you select an OpenStorage storage destination that you want to use
for restoring the recovery points.

Map a network drive

Lets you specify a shared network folder path and assign a drive letter to
it. You can then use Browse to locate the recovery point file you want.

Recovery point details

When you identify a recovery point in the Recovery point folder and
filename box, various details are displayed in this area about the recovery
point. These details can help ensure that you have selected the right
recovery point to restore your computer.

Edit Target Drive options
The Edit target drive dialog box appears when you click Edit in the Drives to Recover panel of the

wizard. You can select a drive that you want to recover. You can then set the options that you want to

perform during the recovery process.

Table: Edit Target Drive options




Option

Description

Delete Drive Lets you delete a selected drive in the list to make space available to
restore your recovery point. When you click Delete Drive, the drive is
only marked for deletion. The actual deletion of the drive takes place
after you click Finish in the wizard

Undo Delete Lets you return a deleted drive to the list of drives to recover.

Resize drive after recover
(unallocated space only)

Lets you select a disk (or volume label) that you want to resize after the
recovery point is restored. Then, you can select this option and specify

the new size in megabytes. The size must be greater than the identified
size of the disk that you selected in the list.

Partition type

Lets you set the partition type as follows:

e Primary partition: Because hard disks are limited to four
primary partitions, select this type if the drive has four or fewer
partitions.

e Logical partition: Select this type if you need more than four
partitions. You can have up to three primary partitions, plus
any number of logical partitions, up to the maximum size of
your hard disk.

Check for file system errors
after recovery

Lets you check the restored drive for errors after the recovery point is
restored.

Set drive active (for booting
operating system)

Lets you make the restored drive the active partition (for example, the
drive from which the computer starts). You should select this option if
you restore the drive on which your operating system is installed.

Restore original disk
signature

Lets you restore the original, physical disk signature of the hard drive.
Disk signatures are part of all Windows operating systems that Veritas
System Recovery 22 supports. Disk signatures are required to use the
hard drive.
Select this option if either of the following situations are true:

e Your computer's drive letters are atypical (for example,

assigned letters other than C, D, E, and so forth).
* You restore a recovery point to a new, empty hard disk.

Restore master boot record

Lets you restore the master boot record. The master boot record is
contained in the first sector of a physical hard disk. The master boot
record consists of a master boot program and a partition table that
describes the disk partitions. The master boot program analyzes the
partition table of the first, physical hard disk to see which primary
partition is active. It then starts the boot program from the boot sector
of the active partition.

This option is recommended only for advanced users and is available
only if you restore a whole drive from within Veritas System Recovery
Disk.

Select this option if any of the following situations are true:

* You restore a recovery point to a new, empty hard disk.

e You restore a recovery point to the original drive, but the
drive's partitions were modified since the recovery point was
created.

* You suspect that a virus or some other problem has corrupted




‘ your drive's master boot record.

OpenStorage destination options for backup and recovery
The OpenStorage Destination dialog box lets you select the cloud destination that you want to use for

backup and recovery.

Table: OpenStorage Destination options for backup and recovery

OpenStorage | Option and | Option and Option and | Option and Option and
Destination Description | Description Description | Description Description
Server Server Name Log on: Log on: Logical storage
Type User name | Password unit
Amazon S3 S3 amazon:amazon.com | Amazon Amazon account | The storage
account secret key. unit is called a
access key. bucket.

Microsoft Azure azure:azure.com Microsoft Microsoft Azure | The storage

Azure Azure storage account | unitis called a

storage access key. You container/blob.
user name. | can enter the

primary access

key or the

secondary

access key.

Generic S3 S3 compatible-with- Provider Provider The storage
S3:instance Account Account secret unit is called a
name access key. | key. bucket.

Veritas S3 vtas-access:instance | Provider Provider The storage

Access name Account Account secret unit is called a

access key. | key. bucket.

For recovery and Recovery Point Browser, click OK.

The OpenStorage File Selection dialog box is displayed.

Based on the logical storage unit that you select, all available recovery points are listed. In Select the
recovery points (*.v2i) that you want to restore, select the recovery points.

For the recover my computer, recover files and folders, recovery point browser, the Filename option,

lets you select only one .v2i, .iv2i file and for System, you can select only one .sv2i file.

Note: For Generic S3 and Veritas Access, you can create the cloud instance using the Cloud Instance
Creator Utility and use the cloud instance as the OpenStorage destination when you define backups and

use the cloud instance as the OpenStorage destination for restores.




Recovering a computer from a virtual disk file using the Veritas System

Recovery Disk

Using Veritas System Recovery Disk, you can recover your computer from within a virtual disk file (.vmdk
or .vhd). If you have a virtual disk for the hard drives that you want to recover, you can fully recover
your computer. Or, you can recover another hard drive back to the state it was in when the original
virtual disk was created.

Note: If you restore a virtual disk of a system drive, the Restore Anyware feature is automatically
enabled for you. During such a recovery, you might be prompted to supply disk drivers, service packs,
hot fixes, and so forth. You should have your Windows media CD available.

Warning: Before you restore a computer using Restore Anyware, test your access to the virtual disk in
the recovery environment. You should ensure that you have access to SAN volumes and that you can
connect to the network.

To recover a computer from a virtual disk file using the Veritas System Recovery Disk
1. Boot the computer by using the Veritas System Recovery Disk.
2. On the Home panel, click Recover My Computer.
3. Inthe Welcome to the Recover My Computer Wizard panel, click Next.

4. Inthe Select a Recovery Point to Restore panel, in the View recovery points by list, select
Filename.

If disks with no layout structures are detected, you are prompted to initialize the disk layout. A
list of disks without layout structures is displayed. The list shows the default disk layout type,
either GPT, or MBR. If required, you can change the layout type for the disks, and then click OK
to initialize layouts on them.

5. Click Browse. If the virtual disk file is located on a network instead, you may need to first click
Map a network drive. You can then specify a shared network folder path and assign a drive
letter to it so you can browse the location.

If the recovery point is located in a hidden drive, you must specify the location of the hidden
drive in the following format:

DiskNo-PartitionNo\Filename.vmdk or DiskNo-PartitionNo\Filename.vhd

For example, if the hidden drive location is on Disk 2 and Partition 3, you must enter 2-
3\file.vmdk. Where 2 is the disk number and 3 is the partition number.

6. Inthe Open dialog box, in the Files of type list, select Virtual Disks (*.vhd, *.vmdk, *.vhdx,
* v2i).



10.

11.

12.

13.

14.

15.

16.

17.

Locate and select a virtual disk file, and then click Open.

Click Next.

In the Target Drive panel, select the target drive where you want to restore the virtual disk.
Optionally, do any of the following:

e Click Delete Drive. Delete a selected drive in the list to make space available to restore your
virtual disk. When you click Delete Drive, the drive is only marked for deletion. The actual
deletion of the drive takes place after you click Finish in the wizard.

¢ Click Undo Delete. If you delete a drive and then change your mind, click Undo Delete to
return the drive to the list.

Click Next.

If necessary, enter the product license key. A license key is required to use Restore Anyware
when you recover a system from a virtual disk file.

Click Next.
In the Recovery Options panel, set the options you want.
Click Next.

Review the recovery options that you selected. You can optionally select Reboot when finished.
This option automatically restarts the computer after the recovery process finishes.

Click Finish, and then click Yes to begin the recovery process.

Target Drive options

If there

is insufficient space to restore your virtual disk, you can delete drives to make unallocated space

available.

Table: Target Drive options

Option Description

Select a target drive or unallocated | Indicates the target drive where you want to restore the virtual
space disk.

Undo Delete Lets you return a deleted drive to the list of drives to recover.
Delete Drive Lets you delete a selected drive in the list to make space available

to restore your virtual disk. When you click Delete Drive, the
drive is only marked for deletion. The actual deletion of the drive
takes place after you click Finish in the wizard.




Restore Anyware options
Restore Anyware lets you recover an operating system drive to a computer that has different hardware

from the original computer.

Table: Restore Anyware options

Option

Description

Use Restore Anyware to
recover to different
hardware

This option is automatically selected for you if you recover a virtual disk.
Or, if you recover an operating system drive (the drive on which
Windows is installed; usually the C drive).

This option is not selected if you restore a virtual disk that contains a
data drive.

If you select this option when the virtual disk contains data only, the
option is ignored at the time of restore.

License key

A license key may be required to use the Restore Anyware option when
you recover a system from a virtual disk file.

A license key is not required if you added the key directly to a custom
Veritas System Recovery Disk that you created yourself. For more
information about creating your own custom Veritas System Recovery
Disk, see the Veritas System Recovery 22 User's Guide.

Recovery options

You can set various the options that you want to perform during the recovery process of a virtual disk.

The options that are available depend on the target drive that you selected earlier in the wizard.

Table: Recovery options

Option

Description

Verify recovery point before
recovery

This option is not available when you recover a virtual disk.

Check for file system errors
after recovery

Checks the restored drive for errors after the recovery point is
restored.

Resize drive after recover
(unallocated space only)

Lets you specify the new drive size in megabytes.

Partition type

Sets the partition type as follows:

¢ Primary partition: Because hard disks are limited to four
primary partitions, select this type if the drive has four or
fewer partitions.

¢ Logical partition: Select this type if you need more than four
partitions. You can have up to three primary partitions, plus
any number of logical partitions, up to the maximum size of
your hard disk.

Set drive active (for booting
0S)

Makes the restored drive the active partition (for example, the drive
from which the computer starts).

You should select this option if you restore the drive on which your
operating system is installed.




Restore original disk Restores the original, physical disk signature of the hard drive.

signature Disk signatures are part of all Windows operating systems that Veritas
System Recovery 22 supports. Disk signatures are required to use the
hard drive.

Select this option if either of the following situations are true:
e Your computer's drive letters are atypical (for example,
assigned letters other than C, D, E, and so forth).
* You restore a recovery point to a new, empty hard disk.

Restore master boot record Restores the master boot record. The master boot record is contained
in the first sector of a physical hard disk. The master boot record
consists of a master boot program and a partition table that describes
the disk partitions. The master boot program analyzes the partition
table of the first, physical hard disk to see which primary partition is
active. It then starts the boot program from the boot sector of the
active partition.

This option is recommended only for advanced users and is available
only if you restore a whole drive in the recovery environment.

Select this option if any of the following situations are true:

* You restore a recovery point to a new, empty hard disk.

e You restore a recovery point to the original drive, but the
drive's partitions were modified since the recovery point was
created.

e You suspect that a virus or some other problem has corrupted
your drive's master boot record.

Recovering files and folders using the Recovery Point Browser in Veritas
System Recovery Disk

You can use the Veritas System Recovery Disk to recover any files and folders that are lost, damaged,
changed, or deleted on your computer. For example, suppose you created a recovery point three days
ago. Since that time, you accidentally changed an important folder that prevents Windows from starting
properly. In such cases, you can start your computer using the Veritas System Recovery Disk. You can
open the recovery point from three days ago inside the Recovery Point Browser, select the original
folder, and recover it.

To recover files and folders using the Recovery Point Browser in Veritas System Recovery Disk
1. Boot the computer by using the Veritas System Recovery Disk.

2. Inthe browser window of Veritas System Recovery Disk, on the left side of the window, click
Recover.

3. Inthe Recover Data on My Computer panel, click Recover My Files.

4. Do one of the following:




e If Veritas System Recovery Disk finds recovery points on your computer, select a recovery

point from the list, and then click OK.

e If Veritas System Recovery Disk cannot locate any recovery points, you are prompted to

browse to a location. Click OK to dismiss the message. In the Select Recovery Point dialog

box, browse to a recovery point, and then click OK.

5. Inthe tree view pane of the Recovery Point Browser, double-click the drive that contains the

files or folders that you want to restore.

6. Inthe content pane of the Recovery Point Browser, select the files or folders that you want to

restore.

7. Click Recover Files. Where possible, the Recover Items dialog box automatically completes the
Recover to this folder text box with the original path from which the files originated. If the

original location does not include a drive letter you must type the drive letter at the beginning of
the path. While in Veritas System Recovery Disk, drive letters and labels might not match what
appears in Windows. You might have to identify the correct drive based on its label, which is the

name assigned to it.

8. If the original path is unknown or you want to restore the selected files to a different location,

click Browse to locate the destination.

Select a Recovery Point options
You use the Select a Recovery Point panel to help you choose the recovery point that you want to use to

restore files and folders to your computer.

You can view available recovery points by the following:

e The date they were created

e A specific recovery point file name

Table: Select a Recovery Point options

Option

Description

View recovery points by

Lets you select how you want to view recovery points.
You can view recovery points by the following:
e Date
e Filename
The options available on this wizard panel change based on the
selection you make in this field.

Select source folder
(appears only if you select Date
in View recovery points by list)

Lets you set the following options based on viewing recovery points
by date:
e Alllocal drives: (default) Lists all available recovery point files
that may exist on your computer's local drives.
e Browse: Lets you browse to locate a recovery point file (.v2i




or .iv2i) on a local drive. Or, you can browse to a network
folder (you may need to map a network drive first).

¢ Browse for OpenStorage Destination: Lets you select a cloud
destination that you want to use for backups.

e Map a network drive: Lets you specify a shared network
folder path and assign a drive letter to it. You can then use
Browse to locate the recovery point file you want.

Select a recovery point Lets you display the recovery points in the order in which they were
(appears only if you select Date | created. If no recovery points were discovered, the Select a recovery
in View recovery points by list) | point table is empty. In such cases, you can search All local drives on
the computer or Browse to find a recovery point file.

Recovery point folder and If you view recovery points by filename, you can type a local drive
filename path and file name to a recovery point file. Or, you can type a shared
(appears only if you select network path and file name to a recovery point file.

Filename in View recovery e Browse: Lets you browse to locate a recovery point file (.v2i
points by list) or .iv2i) on a local drive. Or, you can browse to a network

folder (you may need to map a network drive first).
Select the Show hidden drives check box to see a list of the
hidden drives along with the list of the other drives. You can
select a hidden drive as a location where you want to store
the recovery points. The hidden drives are displayed in the
following format:
DiskNo-PartitionNo\
For example, a hidden drive is displayed as: 2-3\.
Where 2 is the disk number and 3 is the partition number
Note: By default, this check box is not selected.

¢ OpenStorage Destination: Lets you select an OpenStorage
storage destination that you want to use for restoring the
recovery points.

¢ Map a network drive: Lets you specify a shared network
folder path and assign a drive letter to it. You can then use
Browse to locate the recovery point file you want.

Recovery point details Lets you view various details about the selected recovery point.
These details can help ensure that you have selected the right
recovery point to restore your computer.

OpenStorage destination options for backup and recovery
The OpenStorage Destination dialog box lets you select the cloud destination that you want to use for
backup and recovery.

Table: OpenStorage Destination options for backup and recovery

OpenStorage | Option and | Option and Option and | Option and Option and

Destination Description | Description Description | Description Description
Server Server Name Log on: Log on: Logical storage
Type User name | Password unit




Amazon S3 S3 amazon:amazon.com | Amazon Amazon account | The storage
account secret key. unitis called a
access key. bucket.

Microsoft Azure azure:azure.com Microsoft Microsoft Azure | The storage

Azure Azure storage account | unitis called a
storage access key. You container/blob.
user name. | can enter the

primary access
key or the
secondary
access key.

Generic S3 S3 compatible-with- Provider Provider The storage
S3:instance Account Account secret unitis called a
name access key. | key. bucket.

Veritas S3 vtas-access:instance | Provider Provider The storage

Access name Account Account secret unitis called a
access key. | key. bucket.

For recovery and Recovery Point Browser, click OK.

The OpenStorage File Selection dialog box is displayed.

Based on the logical storage unit that you select, all available recovery points are listed. In Select the

recovery points (*.v2i) that you want to restore, select the recovery points.

For the recover my computer, recover files and folders, recovery point browser, the Filename option,

lets you select only one .v2i, .iv2i file and for System, you can select only one .sv2i file.

Note: For Generic S3 and Veritas Access, you can create the cloud instance using the Cloud Instance

Creator Utility and use the cloud instance as the OpenStorage destination when you define backups and
use the cloud instance as the OpenStorage destination for restores.

About backing up a computer by using the Veritas System Recovery Disk
Using a valid license key, you can create independent recovery points using the Back Up My Computer
feature in Veritas System Recovery Disk. These types of backups are sometimes known as cold backups
or offline backups. You create recovery points of a partition without the need to install Veritas System
Recovery 22 or its agent.

With a cold backup, all files are closed when the backup occurs. You do not copy any data that may be in
the middle of being updated or accessed on the desktop or server. Cold backups are particularly useful
for databases. They ensure that no files are written to or accessed at any time during the backup so you
have a complete recovery point.



You can also use the Veritas System Recovery Disk to create recovery points if you experience any of the
following:

e Alevel of corruption prevents you from starting Windows on the computer.

e Veritas System Recovery 22 does not function properly while it runs on a Windows operating
system.

e You want to back up the condition of a damaged system before you recover. For example,
suppose a server or desktop is severely damaged. You can use the Veritas System Recovery Disk
to back up what remains of the system. Then, you can recover what you can later, after you
restore an independent recovery point.

Note: Recovery points that you create using Veritas System Recovery Disk are restored to
dissimilar hardware using Restore Anyware.

When you create a backup using Veritas System Recovery Disk, you are prompted for a license key only
for the following scenarios:

* You use the original, shipping version of the Veritas System Recovery Disk to create a backup of
a computer. The computer does not have Veritas System Recovery 22 installed.

e The computer that you back up using the original, shipping version of Veritas System Recovery
Disk has an unlicensed installation of Veritas System Recovery 22.

¢ You create a custom Veritas System Recovery Disk on a computer that has an unlicensed
installation (evaluation version) of Veritas System Recovery 22. You then use the custom Veritas
System Recovery Disk. You can use it to create a backup of a computer that does not have an
installation of Veritas System Recovery 22.

¢ Youdid not add a license key at the time you create your own customized Veritas System
Recovery Disk. See the Veritas System Recovery 22 User's Guide for information about creating
your own custom Veritas System Recovery Disk.

Backing up a computer by using the Veritas System Recovery Disk

Using a valid license key, you can create independent recovery points using the Back Up My Computer
feature in Veritas System Recovery Disk. These types of backups are sometimes known as cold backups
or offline backups. You create recovery points of a partition without the need to install Veritas System

Recovery 22 or its agent.

To back up a computer by using the Veritas System Recovery Disk



1. Ifyouintend to store the resulting recovery point on an external USB hard drive, attach the
device to the computer now.

Click Next.

Click Next.

Click Next.
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Use the Veritas System Recovery Disk to boot the computer that you want to back up.

On the Home panel, click Back Up My Computer.

If you are prompted, on the Specify License Key panel, enter a valid license key.

On the Drives panel, select one or more drives that you want to back up.

On the Backup Destination panel, set the destination options you want.

. On the Options panel, set the recovery point options you want.

. Click Finish to run the backup.

. When the backup is finished, click Close to return to the main Veritas System Recovery Disk

Backup Destination options
You can specify the location where you want the recovery point stored after it is created. You can also

rename the recovery point file name.

Table: Backup Destination options

Option Description

Folder Lets you type the folder path to the location where you want to
store the independent recovery point.
You can specify a hidden drive as a location where you want to store
the recovery points in the following format:
DiskNo-PartitionNo\
For example, If 2 is the disk number and 3 is the partition number,
you must specify 2-3\ as the location.

Browse Lets you browse to a location on a local drive where you want to

store the recovery point file. Or, you can browse to a network folder
(you may need to map a network drive first).

Select the Show hidden drives check box to see a list of the hidden
drives along with the list of the other drives. You can select a hidden
drive as a location where you want to store the recovery points. The
hidden drives are displayed in the following format:
DiskNo-PartitionNo\

For example, a hidden drive is displayed as: 2-3\.

Where 2 is the disk number and 3 is the partition number

Note: By default, this check box is not selected.




Browse for OpenStorage

Destination

Lets you select a cloud destination that you want to use for backups.

Map a network drive

Lets you specify a shared network folder path and assign a drive
letter to it. You can then use Browse to locate the path where you
want to store the independent recovery point file.

Recovery point filename

point.

Displays the source drive and suggested file name of the recovery

Rename

Lets you rename the file of a recovery point that you have selected.

OpenStorage destination options for backups
The OpenStorage Destination dialog box lets you select the cloud destination that you want to use for

backups.

Table: OpenStorage Destination options for backups

OpenStorage | Option and | Option and Option and | Option and Option and
Destination Description | Description Description | Description Description
Server Server Name Log on: Log on: Logical storage
Type User name | Password unit
Amazon S3 S3 amazon:amazon.com | Amazon Amazon account | The storage
account secret key. unitis called a
access key. bucket.

Microsoft Azure azure:azure.com Microsoft Microsoft Azure | The storage

Azure Azure storage account | unitis called a

storage access key. You | container/blob.
username. | can enter the

primary access

key or the

secondary

access key.

Generic S3 S3 compatible-with- Provider Provider The storage
S3:instance Account Account secret unit is called a
name access key. | key. bucket.

Veritas S3 vtas-access:instance | Provider Provider The storage

Access name Account Account secret unitis called a

access key. | key. bucket.

Note: For Generic S3 and Veritas Access, you can create the cloud instance using the Cloud Instance

Creator Utility and use the cloud instance as the OpenStorage destination when you define backups and

use the cloud instance as the OpenStorage destination for restores.




Options for backing up a computer by using the Veritas System Recovery Disk
You can set the compression level for a recovery point. You can also add a description to the recovery

point and enable other advanced options.

Table: Options for backing up a computer by using the Veritas System Recovery Disk

Option Description

Compression Lets you set the compression level for a recovery point.

The following options are available:

None: Use this option if storage space is not an issue. However, if the
backup is saved to a busy network drive, high compression may be faster
than no compression. With high compression, there is less data to write
across the network.

Standard (recommended): This option uses low compression for a 40
percent average data compression ratio on recovery points. This setting is
the default.

Medium: This option uses medium compression for a 45 percent average
data compression ratio on recovery points.

High: This option uses high compression for a 50 percent average data
compression ratio on recovery points. This setting is usually the slowest
method. When a high compression recovery point is created, CPU usage
might be higher than normal. Other processes on the computer might also
be slower. To compensate, you can adjust the operation speed of Veritas
System Recovery 22. Doing so might improve the performance of other
resource-intensive applications that you are running at the same time.

Verify recovery Lets you verify whether the recovery point is valid after its creation.

point after

creation

Description Lets you type a description that you want to be associated with the recovery point.
Advanced Lets you set the advanced options that you want to be associated with a recovery

point, such as password protection.

Advanced options

Lets you set the advanced options that you want to be associated with a recovery point, such as

password protection.

Table: Advanced options

Option

Description

Divide into smaller files to

Lets you split the recovery point into smaller files and specify the




simplify archive

maximum size (in MB) for each file. For example, suppose you copy a
recovery point to zip disks from your backup destination. You would
specify a minimum file size of 100 MB, according to the size of each zip
disk.

Disable SmartSector
copying

SmartSector technology speeds up the copying process by copying only
the hard-disk sectors that contain data. However, in some cases, you
might want to copy all sectors in their original layout, whether or not
they contain data.

Lets you copy used and unused hard-disk sectors. This option increases
processing time and usually results in a larger recovery point.

Ignore bad sectors during
copy

Lets you run a backup even if there are bad sectors on the hard disk.
Although most drives do not have bad sectors, the potential for
problems increases during the lifetime of the hard disk.

Use password

Sets a password and enables AES encryption on the recovery point when
it is created.
This check box is selected by default.

Password

Lets you specify a password for the backup. Passwords can include
standard characters. Passwords cannot include extended characters, or
symbols. (Use characters with an ASCII value of 128 or lower.)

You must type this password before you restoreckup or view the
contents of the recovery point.

Confirm password

Lets you retype the password for confirmation.

AES encryption

Encrypts recovery point data to add another level of protection to your
recovery points.
If you upgrade from a previous version to Veritas System Recovery 22,
for older backup jobs where only password protection is defined, you
need to edit the jobs to select the AES encryption level. If you do not
edit the older backup jobs, they continue to run without AES Encryption.
Veritas recommends that you edit the job and select AES encryption
level.
Note: If the Use Password check box is selected, you must define AES
encryption.
Choose from the following encryption levels:

e Standard 128-bit (8+ character password)

¢ Medium 192-bit (16+ character password)

e High 256-bit (32+ character password)

About using the networking tools in Veritas System Recovery Disk
If you store your recovery points on a network, you need access to the network. This access lets you

restore your computer or your files and folders from Veritas System Recovery Disk. The Veritas System

Recovery Disk includes a variety of networking tools that you can use to assist you with recovery.

Note: Additional computer memory might be required to recover your computer or files across a

network.




Starting networking services
If you need to start networking services, you can do so manually.

To start networking services

1. On the Network panel in Veritas System Recovery Disk, click Start My Networking Services. To
verify the connection to the network, you can map a network drive.

Mapping a network drive from within Veritas System Recovery Disk

If you started the networking services after you started the recovery environment, you can map a
network drive. This mapping lets you browse to that drive and select the recovery point that you want
to restore. Or, if you create backups from the recovery environment, you can select a destination that
resides on a network location.

If there is no DHCP server or the DHCP server is unavailable, you must provide a static IP address. You
must also provide a subnet mask address for the computer on which you are running Veritas System
Recovery Disk.

After you provide the static IP address and subnet mask address, you can enter the recovery
environment. However, there is no way to resolve computer names. When you run the Recover My
Computer wizard or the Recovery Point Browser, you can only browse the network by using the IP
addresses to locate a recovery point. You can map a network drive so that you can locate the recovery
points more effectively. Or, you can use the mapped network drive as a destination for recovery points
that you create from within the recovery environment.

To map a network drive from within Veritas System Recovery Disk

1. In Veritas System Recovery Disk, on the Network panel, click Map a Network Drive.
2. Map a network drive by using the UNC path of the computer on which the recovery point is

located. For example: \\computer name\share name or \\IP_address\share name

You can also map a network drive from within the Recover My Computer wizard or the Back Up
My Computer wizard in Veritas System Recovery Disk.

Configuring network connection settings
You can access the Network Configuration window to configure network settings while running in the
Veritas System Recovery Disk environment.

To configure network connection settings

1. Inthe Veritas System Recovery Disk environment, click Network, and then click Configure
Network Connection Settings.



2. If you are prompted to start networking services, click Yes.

Getting a static IP address

You can restore a recovery point that is located on a network drive or share. Sometimes, however, you
cannot map a drive or browse to the drive or share on the network to access the recovery point. The
lack of an available DHCP service can cause such a failure. In such cases, you can assign a unique static IP
address to the computer that is running the recovery environment. You can then map to the network
drive or share.

To get a static IP address

1. Inthe Veritas System Recovery Disk environment, click Network, and then click Configure
Network Connection Settings.

2. Inthe Network Adapter Configuration dialog box, click Use the following IP address.

w

Specify a unique IP address and subnet mask for the computer that you want to restore. Be sure
that the subnet mask matches the subnet mask of the network segment.

Click OK.
Click Close to return to the recovery environment's main menu.
In the Network panel, click Ping a Remote Computer.

Type the address of the computer that you want to ping on the network segment.
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Click OK. If you specified a computer name or a computer name and domain as the address
method, make note of the IP address that is returned. If communication to the storage
computer operates as expected, you can use the Map Network Drive utility to map a drive to
the recovery point location.

Viewing the properties of a recovery point
You can view various properties of a recovery point by using the Recovery Point Browser.

To view the properties of a recovery point

1. Do one of the following:

e In Veritas System Recovery 22, on the View menu, click Tools. Click Run Recovery Point
Browser.

e Onthe Windows Start menu, click Programs > Veritas System Recovery 22 > Recovery
Point Browser.

2. Inthe Recovery Point Browser, in the tree panel, select the recovery point file name that you
want to view.

3. Do one of the following:

e On the File menu, click Properties.



e Right-click on the recovery point file name, and then click Properties.

Recovery Point Properties
The following table describes the information available on the Recovery Point Properties dialog box.

This dialog box is available from the Recovery Point Browser.

Table: Recovery Point Properties

Option Description

Description Displays a user-assigned comment that is associated with the recovery point.
Size Displays the total size (in megabytes) of the recovery point.

Created Displays the date and time that the recovery point file was created.

Compression

Displays the compression level that is used in the recovery point.

Split across multiple
files

Identifies whether the entire recovery point file is spanned over several files.

Password protected

Displays the password protection status of the selected drive.

Encryption

Displays the encryption strength that is used with the recovery point.

Version

Displays the version number that is associated with the recovery point.

Computer name

Displays the name of the computer on which the recovery point was
created.

Restore Anyware

Identifies whether Restore Anyware was enabled for the recovery point.

Search engine support

Identifies whether you enabled search engine support for the recovery
point.

Created by

Identifies the application (Veritas System Recovery 22) that was used to
create the recovery point.

Viewing the properties of a drive within a recovery point
You can view the properties of a drive within a recovery point.

To view the properties of a drive within a recovery point

1. Do one of the following:

e In Veritas System Recovery 22, on the View menu, click Tools. Click Run Recovery Point

Browser.

¢ Onthe Windows Start menu, click Programs > Veritas System Recovery 22 > Recovery Point

Browser.

2. Inthe Recovery Point Browser, in the tree panel, double-click the recovery point file name that
contains the drive that you want to view.

3. Select the name of the drive.

4. Do one of the following:

e On the File menu, click Properties.




¢ Right-click on the drive name within the recovery point, and then click Properties.

Driver properties within a recovery point
The following table describes the information available on the Recovery Point Properties dialog box.

This dialog box is available from the Recovery Point Browser when you select a drive within a recovery

point.

Table: Driver properties within a recovery point

Option

Description

Description

Displays a user-assigned comment that is associated with the recovery
point.

Original drive letter

Displays the original drive letter that was assigned to the drive.

Cluster size Displays the cluster size (in bytes) that is used in a FAT, FAT32, or NTFS
drive.
File system Displays the file system type that is used within the drive.

Primary/Logical

Displays the selected drive's drive status as either the primary partition or
the logical partition.

Size Displays the total size (in megabytes) of the drive.
This total includes used and unused space.
Used space Displays the amount of used space (in megabytes) within the drive.

Unused space

Displays the amount of unused space (in megabytes) within the drive.

Contains bad sectors

Identifies whether there are any bad sectors on the drive.

Cleanly quiesced

Identifies whether the database application quiesced properly when a
recovery point was created.

About the Support Utilities
The Veritas System Recovery Disk environment has several support utilities. Veritas Technical Support

might ask you to use these utilities to troubleshoot any hardware issues that you encounter.

You might be required to supply the information that these utilities generate if you call Veritas Technical

Support for help resolving problems.

Note: You should only use these tools as directed by Veritas Technical Support.




